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Summary

Ansys Mechanical is a finite element analysis (FEA) software used to perform structural analysis 
using advanced solver options, including linear dynamics, nonlinearities, thermal analysis, materials, 
composites, hydrodynamic, explicit, and more. 

In this set of tutorials, we will introduce basic functionalities of Ansys Mechanical through the Ansys 
Workbench interface. Ansys Workbench is the integration and workflow platform that connects Ansys 
products. 

This tutorial will cover how to simulate the extension of bar elements in Ansys Mechanical and expand 
on the techniques associated with meshing of 3D objects.

This tutorial is #2 of a four-part tutorial series that serves as an introduction to Ansys Mechanical. 
Details of the topics covered and the order can be found int he table below. These tutorials build on 
one another, so it is recommended that they are followed in order. Other tutorials can be found on the 
Ansys Education Resources site. 

*This tutorial was created using the 2022R2 Student Version of Ansys Workbench. Some screens may 
look different, depending on your version. Check the Ansys Learning Forum if you have any questions.
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https://forum.ansys.com/?utm_campaign=academic&utm_medium=referral&utm_source=education-resource&utm_content=partner_cross-bu_educator-resource-link_product-page_learn-more_na_en_global&campaignID=7013g000000gv7hAAA



© 2024 ANSYS, Inc.3

Exercise 1: Extension of a stepped bar
Begin by opening Ansys Workbench and open a static structural analysis system. We will leave the 
material as structural steel for this exercise.

Open SpaceClaim and in the sketch plane, draw two concentric circles of 20 mm and 30 mm in diameter.

NOTE:
This tutorial was made using the 22R2 Student 
Version of Ansys Workbench. After the 2023R1 
release, Ansys SpaceClaim became a legacy 
product and Ansys Discovery  (a simulation-
driven design tool that combines instant 
physics simulation, high fidelity simulation and 
interactive geometry modeling in a single easy-
to-use experience) became the primary built-in 
Geometry tool. An example of what the screen 
will look like if using 23R1 or later is shown here. 
If you want to learn more about specifically 
modeling in Ansys Discovery, check out this Ansys 
Innovation Course “Learn Solid Modeling with 
Ansys Discovery”.

Selecting each circle individually, fill the circles so that two surfaces are present on the sketch plane: 
one surface for each circle. 

Exit the sketch editor once the circles are filled.

https://courses.ansys.com/index.php/courses/solid-modeling-ansys-discovery/?utm_campaign=academic&utm_medium=referral&utm_source=education-resource&utm_content=partner_cross-bu_educator-resource-link_course-aic_learn-more_na_en_global&campaignID=7013g000000gv7hAAA

https://courses.ansys.com/index.php/courses/solid-modeling-ansys-discovery/?utm_campaign=academic&utm_medium=referral&utm_source=education-resource&utm_content=partner_cross-bu_educator-resource-link_course-aic_learn-more_na_en_global&campaignID=7013g000000gv7hAAA
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If three surfaces are present within the structure window after selecting complete sketch, it is likely 
that the area between the two circles has been allocated a surface in addition to the full circles. This 
can be deleted from the structure tree by right clicking and selecting delete.

Using the “Pull” tool extend each circle in opposite directions such that the larger cylinder has a length 
of 60 mm, and the smaller cylinder has a length of 120 mm. 

Exit SpaceClaim, your geometry for this exercise is now complete.

Open mechanical by double clicking on the “Model” cell in Workbench.

Last week we used the basic method of creating a mesh by adding a “Sizing” feature in the Mesh tab. 
We allowed the program to control the meshing features outside of the element size. This week we 
will be looking at finer mesh details.

Click on “Mesh” in the outline tree. 

In the “Details of “Mesh”” tree you’ll see drop-down menus for “Display”, “Defaults”, “Sizing”, “Quality”, 
“Inflation”, “Advanced”, and “Statistics”. 

Open the Defaults drop-down and click on the box beside “Element Order”. Ansys automatically 
defaults to “Program Controlled”, by clicking on this box you can determine whether you want to use 
linear or quadratic meshing:

Linear elements feature nodes at the corners of the 3D element while quadratic elements feature 
nodes at the corners as well as a mid-span node on each vertex:
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FEA simulations consist of a series of simultaneous equations relating to the state of deformation 
at each node. Logically, it follows that a simulation using higher degree elements (including more 
nodes) would typically provide higher accuracy results, though this is at a cost of computational time 
and power.

If using an Ansys Student license, be mindful of the node limitations. Check out the Ansys Student 
Product Page for more information.

You can change the default element size by typing a value into the box beside “Element Size”. This will 
be applied to the entire project.

For applying mesh settings to an individual body within the project use the body selection tool, select 
the body of interest, and press the button that corresponds to meshing technique you wish to use.

For this exercise apply a linear, tetrahedral mesh of 5.0 mm to the stepped bar currently open in the 
workspace. 

Select mesh from the project tree and apply a “Method” from the context ribbon at the top of the 
window.

In the “Details” tree change the Method to “Tetrahedrons” and the Element Order from “Program 
Controlled” to “Linear”.

After completing the settings for the method, apply a “Sizing” from the Mesh tab and apply a mesh of 
5.0 mm to the bar.

https://www.ansys.com/academic/students/ansys-student?utm_campaign=academic&utm_medium=referral&utm_source=education-resource&utm_content=partner_cross-bu_educator-resource-link_product-page_learn-more_na_en_global&campaignID=7013g000000gv7hAAA

https://www.ansys.com/academic/students/ansys-student?utm_campaign=academic&utm_medium=referral&utm_source=education-resource&utm_content=partner_cross-bu_educator-resource-link_product-page_learn-more_na_en_global&campaignID=7013g000000gv7hAAA
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The behavior of the sizing is either “Soft” or “Hard”. A soft behavior implies the meshing will apply an 
approximate mesh size of 5.0 mm while keeping the aspect ratio within an acceptable range, while a 
hard behavior will force Ansys to apply elements of exactly 5.0 mm to the geometry. Elements with a 
higher quality aspect ratio feature equilateral triangles and squares as the faces, which are generally 
considered to be favorable.

For the moment select “Soft” for the meshing behavior.

Due to the geometry including a sharp corner, more mesh elements are generally required around 
this feature to accurately capture the stresses experienced in this region.

For this object we will also apply a “Sphere of Influence” at the location of the step. 
Create a second sizing method and apply it to the body.

Under the definition drop-down, click on the “Type” drop-down and select “Sphere of Influence”. 
Choose the global coordinate system from the “Sphere Centre” drop-down and change the sphere 
radius to 25.0 mm and the element size to 2.0 mm. 

Generate the mesh.

You can see that the element size is smaller around the step and smoothly transitions to larger elements 
at each end of the bar. This is useful when you are interested in the deformation or stress within a 
particular region of a body and these values are not of particular interest in others. 

This saves computational time and limits the number of nodes and elements compared with applying 
a total body sizing.
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Next boundary conditions and forces will be applied.

Clicking on “Static Structural” in the Project tree, apply a fixed boundary to the bar end of 30 mm 
diameter and a 5 kN force in the positive Y-direction to the 20 mm diameter end.

Moving onto solving the system.

Click on “Solution” in the Outline tree, select a total deformation from the context menu, and equivalent 
stress. 

We will also apply a reaction force analysis to this model.

From the “Probe” drop-down in the solution context menu click “Force Reaction”. 

Select fixed support from the drop-down beside “Boundary Condition”.
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You are now ready to solve for the deformations/stresses of the simulated stepped bar.

Results should show the greatest stresses occur in the smaller bar and the greatest deformation occurs 
at the site of the applied force, as you would expect of a section with a smaller cross section. 

The choice of diameter for the sphere of influence results in the greatest stresses occurring within the 
smallest elements. This is an optimal method of using FEA elements. 

Stresses are derived from deformations, if the nodes are too far from one another the element stresses 
will have a discontinuity across them; excessive discontinuities imply there may be inaccuracies within 
the results.

The simulated deformation can be animated by pressing the play button in the animation section 
beneath the model (shown within the red box).
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Exercise 2: Compression of a tapered bar

This exercise utilizes an externally created geometry. Ensure that your geometry is saved in a 
compatible file format to be imported correctly into Ansys Workbench. 

Create a new Static Structural system and right click on the geometry cell, selecting “Import Geometry” 
and find the supplied geometry part. 

Once the geometry has been imported you will see the icon has changed within the geometry cell.

Right click on the geometry cell again and select “Edit Geometry in SpaceClaim”.

It will take a minute to open the imported geometry. We will use SpaceClaim to split the tapered bar 
halfway along it, creating a new face to place a load along the bar. 

Under the “Design” tab we will need to use both the “Split” and “Split Body” tools to create the new 
face. 

Start by selecting the entire bar and pressing the “Split” tool under the Intersect section of the design 
tools.

Use the line running along the length of the bar, dragging the mouse from one end of the bar towards 
the center, ensuring a circle surrounds the complete perimeter of the bar. 

Type “50” in the top box or use “Tab” and type “500” in the second box (the bar is 1 meter in length), 
so a split is made around the perimeter at the mid length of the bar.
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This split indicates the location where we wish to divide the body.

Once the body has turned purple a circle around the midpoint should be visible. Select “Split Body” 
from the Intersect tools in the Design tab. 

Click on the body, once it turns pink click on the split around the perimeter made previously, this will 
split the entire bar at the center. 

You will see in the Structure tree that the body now has two parts; clicking on either of these will 
highlight the specified section.

The geometry required for this exercise is now complete. 

Exit SpaceClaim, there is no need to save the part unless you intend to use this geometry in the future.

Open Ansys Mechanical by double clicking on the “Model” cell. 

Due to the body split completed in SpaceClaim this part now has two separate bodies. 

Apply a mesh sizing by clicking “Mesh” in the outline tree (changing the context menu) and clicking 
“Sizing” from the mesh tab. 

Use the body select tool, click on one half of the bar, press Ctrl, then press the other half of the bar 
before clicking “Apply” beside Geometry in the “Details of “Sizing” – Sizing” tree from the left-hand 
side of the screen.
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Leave the selection beside “Type” as “Element Size” and apply an Element Size of 20 mm. 

Leave the Behavior under “Advanced” as “Soft”.

Once the bar has turned blue, click “Generate” from the context menu to generate the specified mesh.

Apply a force to the face at the center of the bar by opening the “Geometry” drop down in the Outline 
tree and hiding one of the bodies, right click on one of the bar parts and select “Hide Body”; this will 
allow you select the face at the center of the bar. 

Click on Static Structural from the Outline tree to change the context menu.

Click on “Force” from the Environment tab before selecting the central face and clicking apply. 



© 2024 ANSYS, Inc.12

Apply a load of 500 N to the X Component.

Once the force has been applied, unhide the second half of the bar by right clicking on the hidden body 
under the geometry drop down in the Outline tree and selecting “Show Body”.

The hidden bar will have a translucent tick beside it, as opposed to the shown body which has an 
opaque tick with a line through it. 

From the Static Structural context tab (Environment), apply a fixed support to each end of the bar.

From the Outline tree change to the solution context menu (Solution) by clicking on “Solution (A6)”. 
Select a “Total” deformation, an “Equivalent (Von-Mises)” strain, and an “Equivalent (Von-Mises)” 
stress, before pressing “Solve” from the Solution tab.
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The greatest deformation occurs at the center of the bar, due to the fixed supports at each end of the 
bar.

A slight elongation of the section of the bar in tension is visible, as well as a compression of the other 
end of the bar, resulting in the appearance of a step in the center. 

The maximum stress seen is roughly 30 kPa at the smaller end of the tapered bar, at the perimeter of 
the fixed support.
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Exercise 3: Thermal stresses induced in a tapered bar
Ansys Mechanical is capable of applying different types of loads to geometry. This exercise will focus 
on applying a thermal load, beyond the normal working temperature, to the previously established 
geometry.

Begin by making a new static structural standalone system, importing the “tapered_bar_lab2” file as 
per the previous exercise by right clicking on the “Geometry” cell (you can also share the geometry 
between the systems as per lab 1). There is no need to create a face to apply a thermal load to, we will 
apply it to the entire body.

Double click on the “Model” cell to open Ansys Mechanical.

Apply a mesh of 20 mm to the entire body as per exercise 2. 

Click on “Static Structural (A6)” in the outline tree and apply fixed supports to each end of the bar. 

To apply a “Thermal Condition” to the bar by right clicking on the “Loads” drop-down menu from the 
“Environment” context menu.

You will see that applying a thermal condition opens a Details of “Thermal Condition” window.

Set the bar as the body for the thermal load to be applied to.

From the “Tabular Data” box in the bottom right-hand corner we will apply two different temperatures 
in two timesteps. The selected initial timestep will be set at 22°C (this is the initial assumed working 
temperature). 

Leave timestep “0” as 22°C and enter 200°C as the temperature associated with timestep “1”, by double 
clicking on the cell and changing the value to 200.
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Click on “Solution (A6)” in the Outline tree to change the context menu and apply a “Total” deformation, 
an “Equivalent (Von-Mises)” stress and a “Volume” condition to the static structural simulation. 

You are now ready to solve for this exercise; press the “Solve” button from the context menu.

Increasing the temperature of the bar to 200°C while held between fixed supports causes significant 
expansion of the bar, particularly at the end with a larger diameter (which can be attributed to the 
taper). 
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This can be animated to show the shape of the bar while under expansion. The legend seen at the left 
measures the size of elements in mm3, with the minimum displaying the original volume of elements 
(volume of elements at 22°C).

NOTE: The expansion is exaggerated by the scaling factor found in the upper drop down beside 
“Geometry”. Changing this to “True Scale” displays the actual shape.

The maximum stresses are approximately 1700 MPa and are located at the edges of the fixed supports. 
This is the expected location, considering these are held in place while the bar is forced to expand 
around the edges of the face as expansion cannot occur out of this plane.

This also explains the location of the greatest deformation of the bar; the supported faces are unable 
to deform and so the deformation increases the further you get from the supports as a function of the 
change in volume.
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Use and Reproduction
The content used in this resource may only be used or reproduced for teaching purposes; 
and any commercial use is strictly prohibited. 

Document Information
This case study is part of a set of teaching resources to help introduce students to topics 
focused on structures and structural simulations.

Ansys Education Resources
To access more undergraduate education resources, including lecture presentations 
with notes, exercises with worked solutions, MicroProjects, real life examples and more, 
visit www.ansys.com/education-resources.
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